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Introduction
Introduction

Why use PCsync?
PCsync™ is a file management utility that makes it easy to transfer 
files, migrate settings, synchronize folders, and share files. 

Connect two computers with a LapLink® serial or USB Network cable 
and you can quickly transfer files from one computer to the other. If 
you just bought a new computer, the PCMover™ migration wizard 
helps you copy your personal files and settings from your old 
computer to your new computer. PCsync searches your old computer 
for the types of files and settings you specify, and then copies them to 
your new computer for you.

Using My Net Connections, you can connect to another computer 
across the Internet or your local network. For example, you might 
create a folder on your office computer that you can access from your 
home computer. Or, another PCsync owner can give you permission 
to connect to a folder on her computer.

For local network connections, the Who’s Available Now feature 
displays a list of computers on the network that are currently running 
PCsync. You can select a computer and create an immediate 
connection.

You can create a SmartXchange™ to synchronize any of your local 
and remote folders on demand, so you always have the latest files 
stored in both locations.

With MusicMover™, you can manage your music files and playlists. If 
you want to copy a playlist from one computer to another, this PCsync 
feature copies the playlist and all of its associated music files.

Finally, you can specify a folder on your own computer that you want 
to share with others. PCsync’s Invite feature lets you send an e-mail 
with the connection information they need. You or others can use the 
Surf Up feature to access your shared folder from a computer that is 
not running PCsync, but has Internet access using a browser.

About this guide
The purpose of this Quick Start Guide is to help you set up PCsync 
and introduce you to its features. Look in this guide for examples and 
instructions relating to the main tasks you can do with PCsync. A 
troubleshooting section is also included if you encounter problems.
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Introduction
The exercises in this guide are designed to show you how to use 
PCsync’s key features.You can complete the exercises in order, or 
just learn about the features that interest you most. Refer back to this 
guide as often as needed.
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Before you install
Before you install

System Requirements
PCsync works with the following Microsoft Windows operating 
systems:

• Windows 95 (with Windows Sockets 2.0)

• Windows 98

• Windows 2000

• Windows Me

• Windows NT 4.0

PCsync works with the following Internet browsers:

• Microsoft Internet Explorer 4.01 or later with Java Virtual Machine 
enabled

• Netscape Navigator 4.5 or later with Java Virtual Machine 
enabled (Surf Up requires version 6.0 or later)

Note PCsync detects whether you have certain required files, such 
as Java Virtual Machine or Windows Sockets 2.0. A message 
appears if these files are missing.

If your computer is missing Java Virtual Machine, Setup will prompt 
you to install it. You can also install the files from the PCsync 
Welcome screen or by visiting our website at www.laplink.com/
support.

The required Windows Sockets files are available at 
www.laplink.com/support.

The following lists the requirements for installing PCsync on each 
Windows operating system.

For a computer running Windows 98/Me:

• 16 MB of memory (32 MB recommended)

• Java Virtual Machine version 5.00.3309 or later

• Internet Explorer 4.0 (This provides files that PCsync needs to 
run.)

• 23 MB disk space

• Your Windows CD-ROM 
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Before you install
For a computer running Windows 95:

• 16 MB of memory (32 MB recommended)

• Java Virtual Machine version 5.00.3309 or later

• Windows Sockets 2.0

• Internet Explorer 4.0 (This provides files that PCsync needs to 
run.)

• 23 MB disk space 

• Your Windows CD-ROM 

For a computer running Windows 2000/NT:

• 16 MB of memory (32 MB recommended)

• Java Virtual Machine version 5.00.3309 or later (requires 
Windows NT 4.0 SP3 or higher)

• Internet Explorer 4.0 (This provides files that PCsync needs to 
run.)

• 23 MB disk space 
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Installing and running PCsync
Installing and running PCsync
PCsync comes with two LapLink cables: a blue serial cable and a 
gold USB Network cable. If both computers have a USB port, you can 
use the USB Network cable to transfer files up to seven times faster 
than a serial cable. You must use your LapLink serial cable if you do 
not have a USB port on both computers.

USB Network connections are available with Windows 98, Windows 
Me, and Windows 2000.

Installing PCsync 
1 Insert your PCsync CD-ROM into the CD-ROM drive on your 

computer.

If you have an earlier 
version of PCsync 
already installed on 
your computer, click 
Yes when prompted 
to uninstall it. Then 
choose Installation 
on the Welcome 
screen to restart 
PCsync Setup.

2 On the PCsync Welcome screen, click Installation.

If the PCsync Welcome screen does not appear, open Windows 
Explorer and double-click Welcome.exe on the PCsync CD-ROM.

If PCsync detects that your computer is missing Java Virtual 
Machine, click Yes when prompted to install it. 

If PCsync detects that your computer is missing Windows Sockets 
2.0, go to www.laplink.com/support to locate the required files.

Note: After you install other required software, click Installation on 
the Welcome screen to restart PCsync setup.

3 Follow the instructions that appear on your screen.

Have your Windows CD-ROM on hand if you are planning to use 
your LapLink USB Network or serial cable with PCsync.

Installing the cable software
To install PCsync on 
a second computer 
that doesn’t have a 
CD-ROM drive, 
choose the Make 
Disk option from the 
PCsync Welcome 
screen.

After PCsync has finished copying its files to your hard drive, the 
Setup program will ask if you want to install a cable driver. To connect 
using either the LapLink USB Network cable or the serial cable, you 
must install the appropriate driver.

Installing the USB Network cable software if your computer uses 
Windows 98/Me:

Important You must install the LapLink USB Network cable driver 
software before you connect the USB Network cable to your 
computer.

1 When PCsync Setup prompts you, click Install the software for the 
gold USB cable only.

2 Follow the steps that appear on your screen.
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Installing and running PCsync
If Setup prompts you, insert your Windows operating system CD-
ROM. If you do not have your Windows CD-ROM or Setup cannot 
find the required files, the USB Network Cable may not work 
properly. 

3 Restart your computer.

You must repeat this 
procedure to install 
the USB Network 
cable software on 
your second 
computer.

Now you are ready to connect the LapLink USB Network cable to 
your computer. When you connect the cable, Windows detects the 
new hardware. Follow the instructions on your screen.

Note: If Windows prompts for the location of the driver, browse to the 
folder where you installed PCsync.

Installing the USB Network cable software if your computer uses 
Windows 2000:

Important You must install the LapLink USB Network cable driver 
software before you connect the USB Network cable to your 
computer.

1 When PCsync Setup prompts you, click Install the software for the 
gold USB cable only.

2 Follow the steps that appear on your screen.

3 Click Yes when prompted to install without a digital signature.

4 When Setup prompts you to restart your computer, click Yes.

Now you are ready to connect the LapLink USB Network cable to 
your computer. When you connect the cable, Windows detects the 
new hardware. Follow the instructions on your screen.

Note: If Windows prompts for the location of the driver, browse to the 
folder where you installed PCsync.

Installing the serial cable software:

1 During PCsync Setup, click Install the software for the blue serial 
cable only.

You must repeat this 
procedure to install 
the serial cable 
software on your 
second computer.

2 Follow the steps that appear on your screen.

3 When the cable driver has finished installing, click OK.

4 If prompted to restart your computer, click Yes.

Note: To install the cable drivers at a later time, click the Start button, 
and then point to Programs. Point to the folder that contains PCsync, 
and then click Cable Setup.
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The PCsync window
The PCsync window
The PCsync window has four sections, or panes. The two upper 
panes display information about the cable, local network, and Internet 
connections. The upper panes also display information about pre-
defined transfer jobs, called SmartXchanges. The two lower panes 
display the folders and files on your local computer.

PCsync panes
The upper-left pane is called the PCsync tree. Here you can navigate 
and explore your cable, local network, and Internet connections. You 
can also select a folder on your local computer and invite others to 
share it.

The upper-right pane displays the PCsync file list. This pane lists the 
contents of any item selected in the upper-left pane. For example, if 
you select a cable connection in the PCsync tree, the drives and 
folders on that computer appear in the PCsync file list in the right 
pane.

My Computer file list

My Computer tree

PCsync tree

PCsync file list
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The PCsync window
My Computer panes
The lower half of the PCsync window displays information about your 
computer. You can navigate in these panes much as you do when you 
use Windows Explorer.

All the local and network drives you have access to appear in the 
lower-left pane, or My Computer tree. You can expand the tree to see 
the folders on one or more drives. When you select a drive or folder in 
the My Computer tree, its contents appear in the lower-right pane, or 
My Computer file list.

Working in PCsync
PCsync 
automatically detects 
an existing cable 
connection when you 
start the program on 
the two connected 
computers. 

You can work in PCsync in the same way you are used to working in 
the Windows environment. For example, most features are available 
from the toolbar, menus, and right-click context menus. After you set 
up a connection, you can connect by clicking Connect Now on the 
Connect menu, by clicking the connect button on the toolbar, or right-
clicking the connection and then clicking Connect.
12



Making connections
Making connections
You can connect to another computer over cable, your local network, 
or the Internet. When you start PCsync on two computers connected 
by cable, the connection appears automatically in the upper PCsync 
pane and you can view all the contents of the other computer.

For local network and Internet connections, you set up the connection 
once, then you can connect by double-clicking the connection name 
in the PCsync tree. When you connect over a local network or the 
Internet, you can view the contents of the folder that has been shared 
(and any of its subfolders).

Cable connections
Use the LapLink 
cables that are 
included with your 
copy of PCsync. You 
can also order 
LapLink cables by 
visiting 
www.laplink.com/
products.

PCsync supports LapLink serial cable and USB Network cable 
connections. Use the cables to connect two computers and transfer 
files between them. For example, you can connect your laptop and 
your office computer with a serial or USB Network cable and then use 
PCsync to transfer files from one computer to the other.

If both computers have a USB port, the USB Network cable transfers 
files much faster than a serial cable. You must use your LapLink serial 
cable if you do not have a USB port on both computers. The LapLink 
USB Network cable works with Windows 98, Me, and 2000.

Important If you are using the USB Network cable, you must install 
the USB Network cable driver before you connect the cable to your 
computer. See page 9 for more information.

Try it: Connect two computers by cable

1 Make sure that a LapLink serial or USB Network cable is attached 
to both computers.

2 Start PCsync on both computers.

To turn off the auto-
connect feature, click 
Port Status on the 
Options menu and 
clear the 
Automatically 
Connect at Start-up 
check box.

By default, PCsync automatically detects the cable connection 
and displays the contents of the connected computer in the 
upper-right pane.

You can also connect by double-clicking My Serial Connection or 
My USB Connection in the upper-left pane.
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Making connections
3 Double-click a drive in the PCsync file list to view the contents.

Net Connections
You can connect to a folder that is stored on another computer 
without a cable connection. Net connections include connecting 
across the Internet or over your local network. You can connect to a 
shared folder on someone else’s computer or on another computer 
that you own or use. 

If a coworker has PCsync and her computer is connected to the local 
network, she can designate a folder to share with you. Once she has 
set up a folder to share and provided the connection information you 
need, you are ready to add your Local Network Connection in 
PCsync. For more information about sharing a folder, see page 23.

If you use PCsync on both your home computer and work computer, 
you can add an Internet connection to access a shared folder on 
either computer. You can even access your shared folder from a 
computer that doesn’t have PCsync, using the Surf Up feature. For 
more information, see “Connecting to a shared folder without 
PCsync” on page 24.

Local Network Connections
You can access shared folders on other computers running PCsync 
on your local network. The person sharing the folder must provide 
you with the connection information, including a user name and 
password.
14



Making connections
Try it: Connect to another computer on the local network

1 In the PCsync tree under My Net Connections, double-click Add a 
Local Network Connection.

2 Follow the wizard instructions.

You can also click 
New on the File 
menu, then click 
Local Network 
Connection and 
complete the dialog 
box.

Your new local network connection appears in the PCsync tree, 
and you can browse the contents in the PCsync file list.

Who’s available on the network
PCsync detects other computers on the local network that are 
running PCsync. You can view a list of these computers by clicking 
Who’s Available Now in the PCsync tree.

When you select a computer from the list, PCsync tries to connect to 
that computer. You are prompted for a user name and password 
(supplied by the owner of the computer). The connection is 
automatically added to the PCsync tree.

Note If you don’t select Remember User Name and Password in the 
Log On dialog box, you are prompted for this information each time 
you connect.

Internet Connections
You can also access shared folders by connecting across the 
Internet. Both computers must have an active Internet connection at 
the time you try to connect to the shared folder.

You can connect to a shared folder from a computer running PCsync 
or from your Internet browser (Internet Explorer 4.0 or later or 
Netscape Navigator 6.0 or later) using the Surf Up feature. For more 
15



Making connections
information, see See “Connecting to a shared folder without PCsync” 
on page 24.

You set up an Internet connection in the same way you set up a local 
network connection. Double-click Add an Internet Connection in the 
PCsync tree and follow the wizard instructions. 

When you add an Internet connection in PCsync, you must know the 
unique name assigned to the computer you want to connect to. The 
PCsync owner who is sharing his folder provides you with this 
information. When you set up the connection, you can also enter the 
user name and password for the shared folder. Again, the owner of 
the shared folder provides this information. 

Note If you don’t enter the user name and password when you set up 
the connection, you are prompted for this information each time you 
connect.
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Transferring files
Transferring files
LapLink’s patented SpeedSync™ technology reduces the time it 
takes to update files. As an example, assume that you are using an 
Internet connection to back up a file that contains a large amount of 
text and graphics. The more you work, the larger the file becomes, 
and the longer it takes to update.

SpeedSync accelerates file updates by sending only changes and 
additions. The first time you back up your file, the entire file is copied. 
But after that, only the most recent work is copied. SpeedSync occurs 
automatically, each time you use your cable connections or net 
connections to transfer a file.

Using drag-and-drop
You can use the Windows drag-and-drop feature to transfer files 
between your hard drive in the My Computer panes and your cable or 
net connections in the PCsync panes.

Try it: Transfer a file between two computers that are connected 
by cable

1 In the PCsync tree, click the appropriate cable connection.

The contents of the second computer appear in the PCsync file 
list.

2 Drag a file from the upper-right pane and release it into a folder in 
the lower panes.

A copy of the file appears in the My Computer list pane.

Synchronizing files with SmartXchange
Synchronizing compares the dates of two folders and ensures that 
the newest files exist in both folders. For example, you might use 
SmartXchange to keep your laptop and your office computer 
synchronized with the latest files, or you might replace the contents of 
a folder on one computer with the contents of a folder on another 
computer.

Use the SmartXchange feature to automate regular transfers 
between your hard drive and your cable or net connections. Once you 
create a SmartXchange, use it to synchronize on demand. You can 
run Express SmartXchanges immediately when you create them, or 
run saved SmartXchanges at any time. 
17



Transferring files
Try it: Create a new SmartXchange and synchronize two folders

1 Connect to another computer by cable, the Internet, or local 
network.

2 In either PCsync pane, click the folder you want to include in the 
SmartXchange.

3 In either My Computer pane, click the folder you want to include in 
the SmartXchange. On the toolbar, click the New SmartXchange 
button.

4 In the Name box, type a descriptive name for the SmartXchange.

5 Make sure these are the folders you want to synchronize.

You can change the folder on your hard drive from this dialog box. 
Type the path for the folder you want or click the Browse button 
(...) to navigate to the folder.

6 Click the direction you want the files to be copied, or click Two-
way SmartXchange to put the newest files in both folders. 

7 If you want the SmartXchange to create an exact duplicate of the 
local folder and put it on the remote computer, click Make my 
remote folder a replica of my local folder.

If you want the SmartXchange to create an exact duplicate of the 
remote folder and put it on the local computer, click Make my local 
folder a replica of my remote folder.

8 Check Run SmartXchange Immediately after I click OK.

Your files are now synchronized and your SmartXchange appears 
in the PCsync tree.

To re-use your saved SmartXchange:

1 In the PCsync tree pane, click My SmartXchanges.
18



Transferring files
2 In the PCsync list pane, double-click the SmartXchange you want 
to use.

Understanding the Preview screen
The preview screen appears before any files are actually copied. This 
gives you a chance to make sure that the files will be copied as you 
expect.

• If a file will be added, you see No File Exists.

• If a file will be transferred to the remote computer, you see 
Upload.

• If a file will be transferred to the local computer, you see 
Download.

• If both files have changed since the last time the SmartXchange 
was run, you see Conflict.

Resolving conflicts
Before a SmartXchange runs, all conflicts must be resolved. To 
resolve a conflict:

1 Click the file that displays Conflict.

2 Decide which computer has the file you want to keep.

Tip If you are connected by cable, you may want to open the file 
on both computers before making this choice.

3 Click the Upload arrow to transfer the file to the remote computer 
or click the Download arrow to transfer the file to the local 
computer.

Click the Skip button if you don’t want either file to be copied.

4 Click the Next Conflict button. This will find the next conflict. All 
conflicts have been resolved when the Next Conflict button isn’t 
available.

5 Click OK to copy the files.

Changing your SmartXchange
1 In the PCsync tree pane, click My SmartXchanges.

2 In the PCsync list pane, right-click the SmartXchange you want to 
change, and click Properties.

3 Make the changes you want and click OK.

For more information about using SmartXchange, see the online Help 
within PCsync.
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Transferring files
Using the Migration wizard
PCMover is especially useful if you have purchased a new computer. 
This migration wizard helps you copy your personal files and folders, 
your desktop and network settings, and some application settings 
from your old computer to your new computer.

Use PCMover to:

• Specify the files that you want to copy. For example, you can 
include or exclude specific directories, files types, or individual 
files.

• Search your old computer for desktop settings, such as 
wallpaper, taskbar, icons, and colors.

• Capture network settings, such as the computer name, Windows 
drive mapping assignments, and folder and directory share 
assignments.

• Migrate application settings for Internet Explorer (versions 4.x to 
5.x), Netscape (versions 2.x to 4.x), and Outlook Express 
(versions 4.x to 5.x)

The wizard helps you identify and capture files and settings, then 
builds them into a compressed self-extracting migration package. 
Next, it transfers the migration package from your old computer and 
extracts the files and settings on your new computer. 

PCMover also creates an Undo file. If you want to remove the files 
and settings you have migrated, you simply double-click the Undo file 
on the new computer’s desktop.

Try it: Use the Migration wizard

1 Install PCsync on both computers.

2 Start PCsync on both computers.

3 Connect the two computers over cable or network.

4 From your old computer, click Migrate to a New PC on the 
Transfer menu.

5 If you have more than one connection, select the connection to 
your new computer.

6 Follow the wizard instructions to select the files and settings you 
want to copy to your new computer. 

PCsync automatically transfers the migration package to your 
new computer.

7 From your new computer, follow the instructions that appear on 
your screen to extract the files and settings.
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Managing Music Files
MusicMover helps you manage your digital music library. Use it to 
scan your computer for existing music files, create playlists, and store 
library information about your music collection. With MusicMover, you 
can easily transfer music files between computers using either cable, 
local network, or Internet connections.

MusicMover supports MP3 music files. An MP3 is simply music 
stored in a computer audio format. This format reduces the number of 
bytes in a song without diminishing the sound quality. The difference 
in size allows you to transfer music files more quickly and to store 
more on your computer.

Try it: Transfer your music files

1 In PCsync, click the MusicMover button on the toolbar.

2 In MusicMover, click the Select Destination button on the toolbar.

3 Follow the instructions that appear on your screen to connect to 
the computer that you want to transfer files to.

4 In the Select Music window, select the music files you want to 
transfer.

Or

In the Select Playlists window, select the playlists you want to 
transfer.

5 Click the Transfer Files button on the toolbar.
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Managing Music Files
You can also use MusicMover to:

• Organize your music files into playlists

• View statistics about your music collection

• Play music from your collection on your media player

• Search for songs in your music collection by artist, album, year 
recording, or genre (for example, rock, jazz, or classical)

For more information about MusicMover features, click Contents on 
the MusicMover Help menu.
22



Sharing folders
Sharing folders
The Share My Computer feature lets you set up a folder that you can 
share across the Internet or local network. For example, you can 
share a folder that contains files you and your coworkers are both 
using. Or, you can set up a shared folder on your work computer that 
you can access over the Internet from your home computer.

When you share a folder, you determine what type of access you 
want to allow. For example, if you want to let coworkers modify, add, 
or delete files you have been collaborating on, set up a shared folder 
and give them a full access password. If you want other people to 
retrieve but not change the contents of the folder, you can assign a 
read-only password.

Both you and the 
person connecting to 
your computer must 
be connected to the 
Internet or your local 
network to share a 
folder.

Try it: Set up a shared folder

1 Copy the project files that you want your coworkers to add, 
modify, or delete into a folder on your hard drive.

For example, you could name the folder Our Project.

2 In the PCsync tree, double-click Setup a Shared Folder.

3 Follow the wizard instructions that appear on your screen.

If you selected the option to send an invitation now, the Send 
Invitation to Share dialog box appears. See the next section for more 
information.

Inviting others to share your computer
You can access your own shared folder from another computer 
across the Internet or local network. Or you can allow others to 
access your shared folder across the Internet or local network.

You can click Send 
Invitation to Share in 
the PCsync tree to 
invite others to share 
your folder.

To connect to your shared folder, another user must know the unique 
name you have assigned to your computer and the user name and 
password you’ve defined for security purposes. If you use a MAPI-
compliant e-mail program (such as Microsoft Outlook or Outlook 
Express), PCsync can automatically create an e-mail message that 
you simply address and send. If you use another e-mail program, you 
can create your own message that contains the required information.

You first decide whether you want to want others to only view and 
retrieve files in your shared folder or if you want to allow them to add, 
change, and delete files in your folder. When you use the Invite 
feature, you select the type of access you want to give that person. 
PCsync displays the e-mail message with the appropriate password 
(read only or full access). You simply add the e-mail address and 
send the message.
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Sharing folders
People who have PCsync already installed on their computers can 
set up an Internet or local network connection using the information 
contained in the message. If you invite someone to share your folder 
who does not have PCsync, they can access your folder using their 
Internet browser.

Users must have 
Internet Explorer 4.0 
or later or Netscape 
6.0 or later to share 
your folder without 
PCsync.

Connecting to a shared folder without 
PCsync
Suppose you’re on a business trip and realize you left an important 
file on your computer at work. If PCsync is running on your work 
computer, you can transfer that file from your shared folder to a 
computer that doesn’t have PCsync installed. It’s all done over the 
Internet.

Try it: Connect to PCsync using your Internet browser

1 Verify the following on the computer that you want to connect to:

• PCsync is running and a shared folder has been defined

• You have the necessary connection information for the shared 
folder (unique name for the PC, user name, and password)

• The computer is connected to the Internet

2 Verify the following on the computer that you want to connect 
from:

• The computer has Internet Explorer 4.0 or later or Netscape 
Navigator 6.0 or later

• The computer is connected to the Internet

3 In the browser address box, type http://www.laplink.com/surfup.

4 Enter the Unique Name for the computer running PCsync and 
follow the instructions on the Web pages that appear.

Note You can view, print, and save files to the local computer using 
your browser. You cannot upload files to the shared folder using the 
browser.
24
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Troubleshooting
For help with 
installation and 
connections 
problems, look for 
suggestions in this 
section. If there are 
multiple possible 
solutions to a 
problem, each 
solution is identified 
by a bullet (•). 

PCSync installation troubleshooting
Symptom: When I try to install PCsync the setup program 
freezes the computer. 

There are two possible solutions to this problem

• Make sure you have closed all other applications, then run the 
setup program again. 

• Install PCsync from Windows Safe Mode.

Before restarting the computer in Safe Mode, you must copy 
PCsync to your hard drive because your CD-ROM drive is 
disabled when you run Windows in Safe Mode. 

To copy PCsync to your hard drive:

1 Make sure that your PCsync CD is in your CD-ROM drive.

2 From the Windows Start menu, point to Programs and click 
Windows Explorer. 

If the computer is running Windows Me or Windows 2000, 
right-click the Windows Start menu and click Explore.

3 Click the C: drive. On the File menu, point to New and click 
Folder. In the right window, name the folder PCsync Install and 
press Enter.

4 Double-click the C: drive again in the left window. 

Skip this step if the computer is running Windows NT, 
Windows Me or Windows 2000.

5 Click the CD-ROM drive (it will say PCsync) in the left window.

6 On the Edit menu, click Select All to highlight all of the files 
and folders.

7 Drag the highlighted files to the PCsync Install folder in the left 
pane. 

To start your computer in Safe Mode or VGA Mode:

1 From the Windows Start menu, click Shut Down, then click 
Restart.

2 Watch the computer restart. 

If your computer is running Windows 98 or Me, after the 
memory is checked, press F5. The computer starts directly in 
Safe Mode.
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Troubleshooting
If your computer is running Windows 95, look for the text 
message “Starting Windows 95...” and quickly press F8. 
Choose the Safe Mode option from the Startup menu.

If your computer is running Windows 2000, watch for the text 
message “Starting Windows 2000” and quickly press F8. From 
the Startup menu, choose the Safe Mode option.

If your computer is running Windows NT, choose VGA mode 
from the options displayed.

3 The computer may take several minutes to start, and it will 
look different than when running normally. Click OK when you 
receive the message that the computer is running in Safe 
Mode.

To install PCsync while in Safe Mode:

1 From the Windows Start menu, point to Programs and click 
Windows Explorer.

If the computer is running Windows Me or 2000, right-click the 
Windows Start menu and click Explore.

2 Double-click the PCsync Install folder you created on the C: 
drive.

3 Double-click Welcome.

4 On the Welcome screen, click Installation and follow the 
instructions on your screen.

5 After you click the Finish button, restart your computer and 
allow it to restart normally.

Note If your computer is running Windows 95 and you’ve installed 
Internet Explorer 5.5, PCsync setup displays an error after 
installing. Turn off your computer and restart. If PCsync is not 
installed, contact LapLink Technical Support.

Symptom: When I start the Setup program I get a message 
that IKernel.exe can not be installed. 

There are several solutions to this problem. 

• In the message box, click OK. Wait 10 seconds, then try to run the 
Setup program again.

• If your computer is running Windows NT or Windows 2000, you 
must have administrative privileges before PCsync’s setup 
program can start. Check the user permissions or contact your 
network administrator for assistance.

• If you continue to see this error message, contact LapLink 
Technical Support for assistance.
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Troubleshooting
Uninstalling or reinstalling PCsync
Symptom: When I try to install or uninstall PCsync, I receive 
one of two error messages:

Error number 0x80040702 failed to Load dll: llcintf.dll 
setup (or uninstall) will terminate

Error LLtrack.dll File not Found

This error occurs when the PCsync setup program did not finish 
correctly, either when installing or uninstalling.

If you encounter problems uninstalling or reinstalling PCsync, contact 
LapLink Technical Support.

Serial cable installation troubleshooting
Symptom: I’ve installed the serial cable network adapter, 
but PCsync doesn’t show a serial cable under “My Cable 
Connections.”

Two possible solutions are described here. If you continue to have 
problems after trying these solutions, please contact LapLink 
Technical Support.

• Confirm that no more than five adapters are using the TCP/IP 
network protocol.

To determine how many adapters use TCP/IP network 
protocol:

1 Return to Network Neighborhood using the same steps used 
in the previous solution.

2 If your computer is running Windows 95, Windows 98, or 
Windows Me, on the General tab, count the number of times 
TCP/IP is listed in the list of installed adapters. It will look 
something like this:

TCP/IP -> LapLink Serial Cable Network Adapter

If your computer is running Windows 2000, right-click each 
Local Area Connection and click Properties. Look to see if 
Internet Protocol (TCP/IP) is checked in the list of 
components.

If your computer is running Windows NT, click the Bindings 
tab. Double-click Workstation and double-click WINS Client 
(TCP/IP). Count the number of adapters that are listed.

3 If you have more than five adapters using TCP/IP, you must 
disable or remove one or more adapters before you can install 
either the LapLink serial or USB Network cable.
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Troubleshooting
Note If you need to remove additional adapters, first look for the 
LapLink USB Network Cable. Before removing any additional 
adapters, consider carefully how your other programs may be 
affected by the removal of its adapter. If another program has 
installed an adapter you want to remove, contact their technical 
support group for assistance.

• Uninstall PCsync and restart your computer in Safe Mode, then 
run PCsync setup again.

To reinstall PCsync:

1 From the Windows Start menu, point to Programs, then 
PCsync and click Uninstall. Follow the instructions on the 
screen to remove PCsync from your computer. 

2 When PCsync has been removed, restart the computer in 
Safe Mode as described in the solution on page 26 “Install the 
program from Windows Safe Mode.”

Serial cable connection troubleshooting
Symptom: I’ve installed the serial cable network adapter, 
but I can’t tell if I’m connected.

• Check the My Serial Connection icon (the blue cable icon just to 
the left of the name). If there is a yellow lightening bolt over the 
icon, then you are connected. If necessary, double-click My Serial 
Connection to see the drives on the connected computer.

Note Double-click the drive icon to see the files and folders that 
are on that drive. See page 17 for more information about how to 
transfer files.

Symptom: I’m trying to connect, but nothing happens when 
I click on My Serial Connection. 

Several possible solutions are described here. If you continue to have 
problems after trying these solutions, please contact LapLink 
Technical Support.

Note By default, PCsync automatically displays the contents of a 
computer connected by cable (and running PCsync). To verify that 
this feature is turned on, click Port Status on the Options menu.

• Check that the cable is securely connected to the serial port on 
each computer. 

• Exit and restart PCsync on both computers. Wait about 10 
seconds, and then click My Serial Connection a second time. 
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Troubleshooting
• Check that PCsync has enabled the correct serial port. On the 
Options menu, click Port Status. The correct COM port is enabled 
if a check mark appears next to it. Exit and restart PCsync on both 
computers if you made any changes.

Note The COM port used by the cable and the enabled COM port 
need to be the same. For example, both are named COM1. If you 
need help checking the COM port on your computer, contact your 
computer manufacturer’s technical support group for assistance.

• Turn off the auto-connection feature on one of the computers. On 
the Options menu, click Port Status and clear the Automatically 
Connect on Startup check box.

• Enable only the port where your cable is connected. Go to the 
Options menu and click Port Status. Clear the check mark to 
disable any port not used by PCsync. (See previous Note.) Exit 
and restart PCsync on both computers.

• Set up the serial cable network adapter to use a specific IP 
address. PCsync uses an IP address to recognize each computer 
that you have connected. 

To change the serial cable network adapter’s IP address:

1 If the computer is running Windows 95, Windows 98, or 
Windows NT, right-click the Network Neighborhood icon on 
your desktop and click Properties.

If the computer is running Windows Me or Windows 2000, 
right-click the My Network Places icon on your desktop and 
click Properties.

2 If the computer is running Windows 95, Windows 98, or 
Windows Me, on the General tab in the list of installed 
adapters, double-click this line:

TCP/IP -> LapLink Serial Cable Network Adapter

If the computer is running Windows 2000, click each Local 
Area Connection and look in the left margin for the name of 
the adapter. Right-click LapLink Serial Cable Network Adapter 
and click Properties. Double-click Internet Protocol (TCP/IP).

If the computer is running Windows NT, click the Protocols tab. 
Double-click TCP/IP protocol. In the Adapter box on the IP 
Address tab, change to the LapLink Serial Cable Network 
Adapter.

3 If the computer is running Windows 95, Windows 98, or 
Windows Me, on the IP Address tab, click Specify an IP 
Address.

If the computer is running Windows 2000, click Use the 
following IP address.
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Troubleshooting
If the computer is running Windows NT, click Specify IP.

4 The IP address must be different for each computer that runs 
PCsync. Enter these addresses into the IP address and 
Subnet Mask fields. 

Note It is important that the subnet mask be the same on all 
computers.

For the first computer, enter:

10.0.0.1 for the IP Address

255.0.0.0 for the Subnet Mask

For the second computer, enter:

10.0.0.2 for the IP Address

255.0.0.0 for the Subnet Mask 

If there is a third computer (for example, a laptop that you 
carry between your home and office), enter:

10.0.0.3 for the IP Address

255.0.0.0 for the Subnet Mask

5 Click OK.

6 If prompted, click Yes to restart your computer.

After restarting your computer, start PCsync on both 
computers and, if necessary, double-click My Serial 
Connection. If you still cannot connect, contact LapLink 
Technical Support for assistance.
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Troubleshooting
USB Network cable installation 
troubleshooting
Symptom: I’ve installed the USB Network cable, but PCsync 
doesn’t show my USB cable under “My Cable Connections.” 

• Confirm that the cable has been correctly installed. The cable 
driver (network adapter) must be installed before the cable is 
attached to the computer.

To check for correct installation:

1 If your computer is running Windows 98 or Windows Me, right-
click the My Computer icon on your desktop and click 
Properties. Then click the Device Manager tab.

If your computer is running Windows 2000, right-click the My 
Computer icon on your desktop and click Manage. Then 
double-click Device Manager.

2 Double-click Network Adapters. Look for LapLink USB 
Network Cable. If it is not listed, then the cable was not 
correctly installed.

3 To install the driver, click the Windows Start button, and then 
point to Programs. Point to the folder that contains PCsync, 
and point to Cable Setup. Click Set Up USB Cable. For help 
installing the network adapters, go to page 9 and locate the 
section for your Windows operating system. 

• Confirm that no more than five adapters are using the TCP/IP 
network protocol.

To determine how many adapters use the TCP/IP network 
protocol:

1 If the computer is running Windows 98, right-click the Network 
Neighborhood icon on your desktop and click Properties.

If the computer is running Windows Me or Windows 2000, 
right-click the My Network Places icon on your desktop and 
click Properties.

2 If your computer is running Windows 98 or Windows Me, on 
the General tab, count the number of times TCP/IP is listed in 
the list of installed adapters. It will look something like this:

TCP/IP -> LapLink USB Network Cable

If your computer is running Windows 2000, right-click each 
Local Area Connection and click Properties. Check whether 
Internet Protocol (TCP/IP) is checked in the list of 
components.
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Troubleshooting
If your computer is running Windows NT, click the Bindings 
tab. Double-click Workstation and double-click WINS Client 
(TCP/IP). Count the number of adapters that are listed.

3 If you have more than five adapters using TCP/IP, you must 
disable or remove one or more adapters before you can install 
either the PCsync serial or USB Network cable.

Note If you need to remove additional adapters, first look for the 
LapLink Serial Cable Network Adapter. Before removing any 
additional adapters, consider carefully how your other programs 
may be affected by the removal of its adapter. If another program 
has installed an adapter you want to remove, contact their 
technical support group for assistance.

• Uninstall PCsync and reinstall while the computer is running in 
Safe Mode.

To reinstall PCsync:

1 From the Windows Start menu, point to Programs, then 
PCsync and click Uninstall. Follow the prompts on the screen 
to remove PCsync from your computer. 

2 When the uninstall has completed, restart the computer to 
Safe Mode as described in the solution on page 26, “To install 
PCsync in Safe Mode.”

If My USB Connection still does not appear, please contact 
LapLink Technical Support for assistance with more advanced 
troubleshooting steps. 

USB Network cable connection 
troubleshooting
Summary: I’ve installed the USB Network cable adapter, but 
I can’t tell if I’m connected.

• Check the My USB Connection icon (the gold cable icon just to 
the left of the name). If there is a yellow lightening bolt over the 
icon, then you are connected. Double-click My USB Connection to 
see the drives of the computer you are connected to.

Note Double-click the drive icon to see the files and folders that 
are on that drive. See page 17 for more information about how to 
copy files.

Summary: I’m trying to connect, but nothing happens when 
I click on My USB Connection. 

Note By default, PCsync automatically displays the contents of a 
computer connected by cable (and running PCsync). To verify that 
this feature is turned on, click Port Status on the Options menu.
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Troubleshooting
Several possible solutions are described here. If you continue to have 
problems after trying these solutions, please contact LapLink 
Technical Support.

• Check that the cable is securely connected to the USB port on 
each computer. 

• Exit and restart PCsync on both computers. Click My USB 
Connection a second time. 

• Check to see that PCsync has enabled the USB port. Go to the 
Options menu and click Port Status. The USB port is enabled 
when a check mark appears next to it. Exit and restart PCsync on 
both computers if you made any changes.

• Turn off the auto-connection feature on one of the computers. On 
the Options menu, click Port Status and clear the Automatically 
Connect on Startup check box.

• Change the setup of the USB Network adapter to use a specific IP 
address. PCsync uses an IP address to recognize each computer 
that you have connected. 

To change the USB Network adapter’s IP address:

1 If the computer is running Windows 98, right-click the Network 
Neighborhood icon on your desktop and click Properties.

If the computer is running Windows Me or Windows 2000, 
right-click the My Network Places icon on your desktop and 
click Properties.

2 If the computer is running Windows 98 or Windows Me, on the 
General tab in the list of installed adapters, double-click this 
line:

TCP/IP -> LapLink USB Network Cable

If the computer is running Windows 2000, click each Local 
Area Connection and look to the left margin to see the name 
of the adapter. Right-click the LapLink USB Network Cable 
adapter and click Properties. Double-click Internet Protocol 
(TCP/IP).

3 If the computer is running Windows 98 or Windows Me, on the 
IP Address tab, click Specify an IP Address.

If the computer is running Windows 2000, click Use the 
following IP address.

4 The IP address must be different for each computer that runs 
PCsync. Enter these addresses into the IP address and 
Subnet Mask fields. 

Note It is important that the Subnet Mask be the same on all 
computers.
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For the first computer, enter:

172.29.61.1 for the IP Address

255.255.0.0 for the Subnet Mask

For the second computer, enter:

172.29.61.2 for the IP Address

255.255.0.0 for the Subnet Mask 

If there is a third computer (for example, a laptop that you 
carry between your home and office), enter:

172.29.61.3 for the IP Address

255.255.0.0 for the Subnet Mask

5 Click OK.

6 If prompted, click Yes to restart your computer. After 
restarting, start PCsync on both computers and, if necessary, 
double-click My USB Connection. If the computers still do not 
connect, contact LapLink Technical Support for assistance.
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Where to get more help
PCsync offers these convenient ways to use online Help.

• Browse the Help documentation within PCsync. Click Help Topics 
on the PCsync Help menu or click the question mark on the 
PCsync toolbar to use the Help index and Find features to search 
for specific information.

• Use What’s This Help to view information about items within a 
dialog box. Click the question mark in the upper right hand corner 
of the dialog box, or press the F1 key, and then click the item you 
want help with. You must have focus on the item before you press 
the F1 key. You can also click the Help button in the dialog box to 
view information about the entire dialog box. 

You can also visit www.laplink.com/support and submit questions to 
Technical Support.
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LapLink Inc. License Agreement
IF YOU BREAK THE SEAL OR OTHERWISE OPEN THE PACKAGE CONTAINING THE SOFTWARE PRO-
GRAM MEDIA, YOU ARE BY THAT ACT AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS 
OF THIS LICENSE AGREEMENT.

OWNERSHIP OF SOFTWARE. You acknowledge and agree that all of the computer programs and associ-
ated documentation contained in this package (collectively, the "Software") are owned exclusively by LapLink 
and/or its licensors. The Software is protected under copyright and other intellectual property laws of the 
United States and international copyright treaties. You acknowledge and agree that the price paid by you for 
the Software is a license fee granting you only the rights set forth in this License Agreement.

LICENSE. LapLink grants to you, and you accept, a limited, non-exclusive and revocable license to use the 
Software, in machine-readable, object code form only. You agree to use the Software only as authorized in 
this License Agreement. This License Agreement does not convey to you any ownership rights or any other 
interest in the Software.

SCOPE OF LICENSE. This is a single-user, multiple computer license, which means you are authorized to 
use the Software on up to a total of three personal computers that are used exclusively by you (e.g., office, 
laptop and home). A valid license must be purchased for each person who will use the Software. You may 
only use the Software to link with a computer not used solely by you if the user of that computer has a valid 
license.

If this software is to be installed on a network server, or more than one user can run the Software, you must 
purchase an additional license for each user or work station. Please contact the location where you pur-
chased the Software and this license, or contact LapLink, to obtain additional licenses.

You may not copy or make any changes or modifications to the Software, and you may not translate, decom-
pile, disassemble, or otherwise reverse engineer the computer program(s). You may not loan, rent, lease or 
sublicense the Software or any copy to others for any purpose. You agree to use all reasonable efforts to pro-
tect the Software from unauthorized use, modification, reproduction, distribution or publication. You are not 
permitted to make any uses or copies of the Software that are not specifically authorized by the terms of this 
License Agreement, and LapLink Inc. reserves all rights that are not expressly granted to you. Your adher-
ence to this License Agreement will allow LapLink Inc. to continue developing innovative and useful products 
and providing a high level of customer service and support.

TERM. This license will become effective on the date you acquire the Software and will remain in force until 
terminated. You may terminate this license at any time by removing the Software from your computer and 
destroying the original Software and all copies. This license will automatically terminate if you breach any of 
the terms or conditions set out in this License Agreement. You agree to remove the Software from your com-
puter, and either to destroy the original Software and all copies of the Software and documentation or to 
return them to LapLink, upon termination of this license for any reason.

TRANSFER. You may transfer your license of the Software to another party by transferring the original pro-
gram media and all applicable documentation, including the original of this License Agreement, to the recipi-
ent, who agrees to the terms of this Agreement. All other copies of the Software must be deleted and/or 
destroyed. Any transfer of possession of the Software terminates your license and all associated benefits 
under this License Agreement. You must notify LapLink in writing of such a transfer.

ARCHIVAL COPY. You may make one copy of this Software and associated documentation solely for backup 
or archival purposes. Alternatively, you may transfer this Software to a single hard disk drive, provided that 
you keep the original program media and accompanying documentation in your possession for backup or 
archival purposes. Any such copies of the Software or documentation shall include LapLink's copyright and 
other ownership notices. No other copies of Software or documentation may be made by you or any person 
under your authority or control.

LIMITED WARRANTY. LapLink warrants the physical program media, cable(s) and physical documentation 
to be free from defects in materials and workmanship for a period of 90 days from the date of your purchase. 
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If you notify LapLink of defects in materials or workmanship during the warranty period, LapLink will replace 
the defective program media or documentation or, at its option, refund the purchase price. Your remedy for 
breach of this warranty shall be limited to replacement or refund and shall not encompass any other dam-
ages. No dealer, distributor, agent or employee of LapLink is authorized to make any modification or addition 
to the warranty and remedies stated above.

LAPLINK SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICU-
LAR PURPOSE. LAPLINK DOES NOT WARRANT THE PHYSICAL PROGRAM MEDIA, CABLE, PHYSICAL 
DOCUMENTATION OR COMPUTER PROGRAM(S) OTHER THAN AS EXPRESSLY STATED ABOVE, 
NOR DOES LAPLINK PROVIDE ANY WARRANTY AS TO THE OPERATION OF THE SOFTWARE OR ITS 
FITNESS FOR ANY PARTICULAR APPLICATION, USE, OR PURPOSE.

LIMITATION OF LIABILITIES AND REMEDIES: IN NO EVENT SHALL LAPLINK.COM OR ITS LICENSORS 
HAVE ANY LIABILITY FOR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL, PUNITIVE, OR SPECIAL 
DAMAGES, WHATSOEVER, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE ARISING 
OUT OF THIS AGREEMENT, THE LICENSING OF SOFTWARE BY LAPLINK.COM OR THE PROVISION 
OF MAINTENANCE AND SUPPORT SERVICES BY LAPLINK.COM, EVEN IF LICENSEE HAS ADVISED 
LAPLINK.COM OF THE POSSIBILITY OF SUCH DAMAGES, AND INCLUDING UNDER ANY CLAIM OF 
NEGLIGENCE, STRICT LIABILITY, DESIGN DEFECT, OR OTHER THEORY. IN NO EVENT SHALL THE 
LIABILITY OF LAPLINK.COM OR ITS LICENSORS EXCEED THE PURCHASE PRICE PAID FOR THE 
SOFTWARE, LESS ALL APPLICABLE TAXES AND DUTIES. SOME STATES DO NOT ALLOW THE 
EXCLUSION OR LIMITATIONS OF LIABILITIY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 
THE AFOREMENTIONED LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software is provided with Restricted Rights. Use, duplica-
tion, or disclosure by the United States Government is subject to restrictions set forth in subparagraph 
(c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subpara-
graphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as appli-
cable. Contractor/Manufacturer is LapLink Inc., 18702 North Creek Parkway, Bothell, Washington 98011 
U.S.A.

UPDATES. To receive notification of future Software updates, please complete and return the registration 
card. Also, please locate the serial number of your copy of the Software on the program media. You will need 
this number to receive updates and technical support from LapLink.

TRADEMARKS. LAPLINK, PCSYNC and the associated logo(s) are registered trademarks of LapLink Inc. No 
right or license to any trademarks owned by LapLink or others appearing in the Software or packaging is 
granted to you by this License Agreement.

MISCELLANEOUS. Unless otherwise restricted by law, you agree that this License Agreement shall be con-
strued, interpreted and governed by the laws of the State of Washington of the United States of America, 
without regard to the laws governing conflicts of law. If any action is brought by either party against the other 
regarding any subject matter of this License Agreement, the prevailing party shall be entitled to recover, in 
addition to any other relief granted, reasonable attorney fees and expenses of litigation. You further agree that 
any claim relating to this License Agreement shall be brought in the courts of competent jurisdiction in the 
State of Washington. If any term of this License Agreement is declared void or unenforceable by any court of 
competent jurisdiction, enforcement of the remaining terms shall not be affected. No waiver of any right under 
this License Agreement shall be effective unless in writing and signed by both parties. No waiver of any past 
or present right arising from any breach or failure to perform shall be deemed to be a waiver of any future right 
arising under this License Agreement. This License Agreement sets forth the entire agreement between 
LapLink and you with respect to all matters covered herein.

IF YOU HAVE ANY QUESTIONS CONCERNING THIS LICENSE AGREEMENT, PLEASE CONTACT 
LAPLINK.COM AT 18702 NORTH CREEK PARKWAY, BOTHELL, WASHINGTON 98011 U.S.A. 
(425.483.8088), OR CONTACT YOUR REGIONAL LAPLINK.COM OFFICE.
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